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KEY FINDINGS 
 

 The Intel Core Duo T2400 processor-based 
system ran from 15 to 43 percent faster than 
the AMD Turion 64 X2 TL-52 processor-
based system on our performance tests. 

 The Intel Core Duo T2400 processor-based 
system consumed from 56 to 84 percent less 
energy than the AMD Turion 64 X2 TL-52 
processor-based system during the 
performance tests.  

 The Intel Core Duo T2300E processor-based 
system ran from 8 to 30 percent faster than 
the AMD Turion 64 X2 TL-52 processor-
based system on the performance tests. 

 The Intel Core Duo T2300E processor-based 
system consumed from 44 to 72 percent less 
energy than the AMD Turion 64 X2 TL-52 
processor-based system during the 
performance tests.  

Executive summary 
 
Intel Corporation (Intel) commissioned Principled 
Technologies (PT) to run a set of performance tests on the 
following OEM notebook systems: 
 

• an AMD Turion 64 X2 TL-52 mobile processor-
based system (which we will refer to as OEM 
System A) 

• an Intel Core Duo T2300E mobile processor-
based system (which we will refer to as OEM 
System B) 

• an Intel Core Duo T2400 mobile processor-based 
system (which we will refer to as OEM system C) 

 
The goal of the testing was to gauge the performance and 
energy consumption that buyers would experience when 
performing common tasks. Intel specified the test systems 
and provided the tests, test procedures, and test settings. 
PT purchased and set up the systems and executed all 
tests. To keep the focus of this report on the relative 
performance of the Intel and AMD processors at the core 
of the test systems, Intel requested we not disclose the 
OEM name.  
 
We measured system performance and energy consumption with the following five custom tests designed to 
simulate tasks that users commonly perform on notebook PCs: 
 

• Music ripping, which uses Apple iTunes 6.0.5 to rip a .wav music file to mp3 format 
• Photo editing, which opens and automatically adjusts exposure, contrast, and color in a group of 200 

digital photos using ACD Systems ACDSee 8 Photo Manager 
• Photo editing, which opens and automatically "smart fixes" a group of 103 digital photos using Adobe 

Photoshop Elements 4.0 
• Video encoding for iPod, which converts a raw DV file to an iPod-compatible MP4 file using InterVideo 

iVideoToGo for iPod 4.5 
• Video encoding for home use, which encodes a wmv file from a raw DV video file using Microsoft 

Windows Movie Maker 2.1 
 
As the Key Findings detail, the systems with the Intel processors ran faster and used less energy on all the tests 
than the system with the AMD processor. 
 
Appendix A provides the price of the test systems, and Appendix B details their configurations. 
 

Test results 
Table 1 summarizes the performance results and energy consumption measurements of each test. Each result is 
the median of three runs on each system. (In the event of a tie, we chose the run with the higher energy 
consumption. If the energy consumption score was also tied, we then chose the first run we executed with those 
scores.) For these performance and energy consumption measurement tests, lower scores are better because 
they represent the time or the energy the system required to complete each workload.  
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We used the Intel Power Acquisition Recording Kit (iPARK) to gauge energy consumption. The iPARK device is 
an external unit that connects to a host computer through a USB cable. It also has a DC power cable that powers 
the system under test. We used the iPARK device to monitor the average DC energy consumption of each 
system while under load. We then multiplied iPARK’s average DC power score by the time the workload took to 
complete to calculate the Workload Energy Consumption (WEC) in Watt-seconds. We divided the WEC Watt-
seconds score by 3600 (the number of seconds in an hour) to calculate the WEC Watt-hours we reported below.  
 
Because screen brightness can affect the amount of energy a system consumes, for each pair of comparison 
systems we set the brightness to be as close as we could make it to the brightness of the dimmer of the two 
systems. Consequently, each Intel Core Duo processor-based system was actually slightly brighter than its AMD 
Turion processor-based comparison system. The nits measurements in parentheses below each system name in 
Table 1 gives the brightness at which we tested each system.  
 
In the rightmost column of each result set, we compare the median results of the systems. We calculate this 
comparison by dividing the AMD Turion processor-based system’s score by the Intel Core Duo processor-based 
system’s score. Consequently, comparative results above 1.00 indicate tests on which the Intel Core Duo 
processor-based system performed better or was more energy-efficient, and those below 1.00 indicate tests on 
which the AMD Turion processor-based system performed better or was more energy-efficient.  
 

Performance Results 
(seconds) Comparative Ratings 

Benchmark or Test 
OEM 

System A 
AMD Turion 
64 X2 TL-52 

1.6 GHz 
(61 nits) 

OEM 
System B 
Intel Core 

Duo T2300E 
1.66 GHz 
(69 nits) 

OEM 
System C 
Intel Core 

Duo T2400 
1.83 GHz 
(75 nits) 

OEM 
System A 

AMD Turion 
64 X2 TL-52 

1.6 GHz 
(61 nits) 

OEM 
System B 
Intel Core 

Duo T2300E 
1.66 GHz 
(69 nits) 

OEM 
System C 
Intel Core 

Duo T2400 
1.83 GHz 
(75 nits) 

Custom Tests 
ADC Systems 
ACDSee8 Photo 
Manager 

220 203 191 1.00 1.08 1.15 

Adobe Photoshop 
Elements 4.0 381 293 266 1.00 1.30 1.43 

Apple iTunes 6.0.5 157 134 124 1.00 1.17 1.27 

InterVideo 
iVideoToGo for 
iPod 4.5 

85 69 61 1.00 1.23 1.39 

Microsoft Windows 
Movie Maker 2.1 106 91 85 1.00 1.16 1.25 

 
 Table 1: Performance results and comparative performance ratings for the three test systems. For performance results, lower 
numbers are better. For comparative ratings, higher numbers are better.
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Energy Consumption Results 

(watt hours) Comparative Ratings 

Benchmark or Test 
OEM 

System A 
AMD Turion 
64 X2 TL-52 

1.6 GHz 
(61 nits) 

OEM 
System B 
Intel Core 

Duo T2300E 
1.66 GHz 
(69 nits) 

OEM 
System C 
Intel Core 

Duo T2400 
1.83 GHz 
(75 nits) 

OEM 
System A 

AMD Turion 
64 X2 TL-52 

1.6 GHz 
(61 nits) 

OEM 
System B 
Intel Core 

Duo T2300E 
1.66 GHz 
(69 nits) 

OEM 
System C 
Intel Core 

Duo T2400 
1.83 GHz 
(75 nits) 

Custom Tests 
ADC Systems 
ACDSee8 Photo 
Manager 

2.65 1.84 1.70 1.00 1.44 1.56 

Adobe Photoshop 
Elements 4.0 4.29 2.49 2.41 1.00 1.72 1.78 

Apple iTunes 6.0.5 2.15 1.40 1.31 1.00 1.54 1.64 

InterVideo 
iVideoToGo for 
iPod 4.5 

1.07 0.65 0.58 1.00 1.65 1.84 

Microsoft Windows 
Movie Maker 2.1 1.49 0.99 0.92 1.00 1.51 1.62 

 

Test methodology 
Configuration differences 
We purchased the built-to-order systems online. We made them as identical as possible and as close in price as 
possible, but we could not avoid the following differences: 
 

• The hard drive controllers in the systems differ. Though all three are SATA 150 devices, the AMD Turion 
processor-based system uses the nForce 410/430 MCP controller, while the two Intel Core Duo 
processor-based systems use the Intel 82801GBM (ICH7-M) controller. 

• The Intel Core Duo processor-based systems came with the integrated Intel GMA 950 video adapter with 
128 MB of video RAM. The AMD Turion processor-based system, by contrast, came with an NVIDIA 
GeForce Go 6150 graphics adapter with 256 MB of video RAM. 

• The prices differ. (We exclude shipping and tax charges.) The AMD Turion processor-based system cost 
$1,213.99, the comparison Intel Core Duo T2300E processor-based system cost $1,023.99, and the 
comparison Intel Core Duo T2400 processor-based system cost $1,218.99. 

Initial setup 
When the systems arrived, we unpacked and set up each one. We went through the following process with each 
mobile PC the first time we booted it: 
 

1. Press Next at the Welcome to Microsoft Windows screen. 
2. Select United States, English and U.S. keyboard. Press Next. 
3. Select Eastern Time. Press Next. 
4. Select Yes, I accept the Microsoft End User License Agreement. Press Next. 
5. Select Not right now to automatic updates (because our goal is to test each PC as it came directly out 

of the box). Press Next. 
6. Name each computer with its model. 
7. Leave the computer description blank. Press Next. 
8. Select Skip at the registration screen. 

Table 2: Energy consumption results and comparative energy consumption ratings for the three test systems 
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9. Enter User in the Your name field. Press Next. 
10. Select Finish. 
11. Select Exit at the Easy Internet Sign-up screen. 
12. Select No, do not send any data and check the box that says do not show me this again at the 

Customer Experience Enhancements screen. Press Continue. 
13. Click Start at the Easy Setup screen. 
14. Uncheck the Notify me when critical product updates are available option. Press Next. 
15. Press Next at the Support Tools screen. 
16. Press Next at the Extended Service Plans screen. 
17. Press Next at the Register screen. 
18. Select the Microsoft Internet Explorer 6 option at the Select your Browser screen, and press Next. 
19. Select Launch Norton Internet Security AntiSpyware Edition when I finish Easy Setup. Press Next. 
20. Press Finish at the Setup Complete screen. 
21. Press Next at the Norton Internet Security 2006 screen. 
22. Select I accept the License Agreement, and press Next. 
23. Press Next at the Subscription Status screen. 
24. Press Finish at the Next Steps screen. 
25. Press Next at the Welcome to LiveUpdate screen. 
26. Press Finish. 
27. Close the Norton Internet Security Protection Center. 
28. Select No, never show this message again at the Recovery Disc Reminder. Press OK. 
29. Click Cancel to the Software Updates pop-up. 
30. Right-click the desktop, and select Properties. 
31. Under the Screen Saver tab select None for the Screen saver, and click Apply. 
32. Also under the Screen Saver tab, select the Power button.  
33. Under the Power Schemes tab leave the default Portable/Laptop power scheme and select Never for all 

power settings. 
34. Under the Hibernate tab uncheck Enable hibernation, and press OK. 
35. Select Notify me again in 14 days, and uncheck Enable automatic LiveUpdate at the Norton AntiVirus 

Definition Alert dialog box. 
 
We used Symantec’s Ghost product to capture an exact image of the hard disk to a DVD using the internal DVD-
RW drive. Each time we ran a new benchmark or test on a machine, we used the Ghost image DVD to return that 
machine to the above configuration. After re-imaging, we installed the software necessary to run each test and 
rebooted. 
 
Before starting a test, we allowed each notebook PC's screen to warm up for at least 15 minutes. We did this by 
opening Microsoft Paint, pressing Ctrl-E, and setting the width and height larger than the screen resolution. We 
then pressed Ctrl-F to make the entire screen display a white background.  
 
Before each test run we used a Gossen Mavolux 5032C luminance meter on the white background to try to 
normalize the screen brightness of all the systems. We did this because screen brightness can affect the amount 
of energy a system consumes. We set the brightness to be as close as we could make it to the brightness of the 
dimmest of the systems. Consequently, we set the AMD Turion processor-based system to approximately 61 nits 
and the Intel Core Duo processor-based models to 69 and 75 nits. Tables 1 and 2 show the actual screen 
brightness during the test of each system. 
 
Before each run, we manually deactivated each system’s wireless adapter using the external toggle button, 
because of the effect of the wireless adapter on energy consumption.  
 
We rebooted before running each test. 
 
We measured each system’s energy consumption with an Intel Pentium 4 Extreme Edition 3.73 GHz host 
computer using the Intel Power Acquisition Recording Kit (iPARK).  
 
We followed these steps for setting up and running iPARK: 
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iPARK setup and test procedure 
We followed this process to set up the iPARK device and software. 
 

1. Power off the notebook PC under test. 
2. Remove the battery from the notebook PC. 
3. Connect the iPARK DC power cable into the notebook PC’s power port. 
4. Plug both AC power cables from the iPARK device into the wall. Verify that the blue light on the Targus 

power brick is on. 
5. Connect the iPARK USB cable to the host computer. 
6. Turn on the iPARK power switch. A red light should glow on the power switch. 
7. Turn on the host computer. 
8. Insert the iPARK software installation CD into the host computer, and install the software as follows: 

a. Click Next at the Welcome screen. 
b. Click Yes at the Software License Agreement screen. 
c. Click Next at the Choose Destination Location screen. 
d. Click Next at the Select Program Folder screen. 
e. Uncheck View the README file and click Finish. 
f. Click OK to the Microsoft .NET Framework v1.1.x not found warning. 
g. Click Run at the next two Windows Security Warnings. 
h. Click Yes at the Microsoft .NET Framework 1.1 Setup screen. 
i. Select I agree at the license agreement and click Install. 
j. Click OK at the Installation Complete screen. 
k. Reboot the system. 
l. Insert the iPARK patch CD, and uncompress the files to the C:\iPARK directory. 
m. Select Yes To All when the installation software asks about overwriting files. 

9. Calibrate the iPARK software by going to Start All Programs Intel Power Acquisition Recording 
Kit Intel Power Acquisition Recording Kit Calibration. 

10. Click OK at the PMD-1208LS (serial# 130) dialog. 
11. Highlight the Bd#0-PMD-1208LS (serial# 130), and click on the Configure icon found in the menu bar. 
12. Select 8 Single Ended from the no. of Channels field, and click OK. 
13. Exit the iPARK calibration tool. 

 
We followed the process below to measure energy consumption during a test. 
 

1. Power on the notebook PC, and make sure you have prepped it to run a test. 
2. Start the Intel Power Acquisition Recording Kit Logging Tool. 
3. In the Name field, type a name that appropriately describes the platform and configuration. We used the 

following naming convention: test_processor_RunX (e.g., iTunes_CoreDuo_Run1). 
4. Use the same naming convention in the Log File field (e.g., iTunes_CoreDuo_Run1). 
5. Click the iPARK start button at the same time you start a test to begin logging immediately. 
6. Click the iPARK Stop button at the same time you stop a test. 
7. Click the Log File button to view the test log. 
8. Multiply the time (in seconds) that the system took to complete the test by the Average DC Power (Watts) 

score. Divide this number by 3600 to calculate the Workload Energy Consumption (WEC) in Watt-Hours. 
 
The following subsections summarize the steps we followed to obtain each of the test results in this report. 

Test using ACD Systems ACDSee 8 Photo Manager 
Intel provided the 200 .jpeg images this test uses. These files have the following key characteristics: 
 

• Resolution: Range from 2000W x 3008H to 3008W x 2000H (all 300 dpi horizontal x 300 dpi vertical) 
• Size: Range from 1,492KB (1,527,628 bytes) to 3,241KB (3.318,019 bytes); average size is about 

2,367KB 
• Bit depth: 24-bit color 
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We performed the following steps to run this test: 

Installing ACDSee 8 Photo Manager 
1. Reset the system to the base test image. 
2. Install ACDSee 8 Photo Manager with its default settings. 
3. Reboot the system. 

 

Running the ACDSee 8 Photo Manager performance test 
1. Launch ACDSee 8 via its desktop icon. 
2. If a Quick Start Guide dialog appears, uncheck Always show when ACDSee starts, and click Close. 
3. If a myACD Daily Offer dialog appears, click Close. 
4. If a Catalog Files Wizard dialog appears, click Cancel. 
5. The ACDSee 8 Photo Manager main interface should appear. 
6. On the Folders sub-window in the upper left, navigate to the folder that contains the photo workload. The 

photos should appear in the middle sub-window. 
7. Click in the middle sub-window that shows those photos, and press Ctrl-A to select all photos in the 

folder. 
8. From the Tools Menu, click Tools Adjust Image Exposure… 
9. The Batch Adjust Exposure dialog will appear. 
10. Make sure the following settings are selected: 

• On the Auto Exposure Tab: Auto Contrast and Color 
• On the main window: Apply settings to all selected images 

11. Prepare the stopwatch. 
12. Start the stopwatch, and click the Filter All Images button at the same time. 
13. A Changing the Exposure of Your Files dialog will appear. It will include two progress bars that indicate 

the scenario’s progress. 
14. When ACDSee has finished the scenario, the progress bars in the dialog above will be full, and a Done 

button will appear at the bottom of the dialog.  
15. Stop the stopwatch.  
16. Record the elapsed time on the stopwatch. 
17. Close the above dialog, and exit ACDSee Photo Manager. 
18. Navigate to the folder with the photo workload, and delete all the edited versions of the photos that 

ACDSee Photo Manager created. 
19. Empty the Recycle Bin. 
20. Reboot the system 
21. Repeat the test two more times.  

 
We report the time, in seconds, that ACDSee 8 Photo Manager took to process the photos. Lower times indicate 
faster performance and so are better. 

Test using Adobe Photoshop Elements 4.0 
Intel provided the 103 .jpeg images this test uses. These files have the following key characteristics: 
 

• Resolution: Range from 640W x 480H to 2048W x 1536H (all 180 dpi horizontal x 180 dpi vertical) 
• Size: Range from 60KB (61,440 bytes) to 988KB (1,011,712 bytes); avg size is about 600KB 
• Bit depth: 24-bit color 
 

We performed the following steps to run this test: 

Installing Adobe Photoshop Elements 4.0 and preparing for the test 
1. Reset the system to the base test image. 
2. Install Adobe Photoshop Elements 4.0 with its default settings. 
3. Reboot the system. 
4. Copy the workload to a flash drive. 
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Running the Adobe Photoshop Elements 4.0 performance test 
1. Insert the flash drive into a USB port.  
2. Adobe Photo Downloader will automatically launch.  
3. Deselect the automatically fix red eyes feature in the Adobe Photo Downloader.  
4. Click the Get Photos button. 
5. The program automatically imports all the photos from the flash drive to the system's hard disk. 
6. Adobe Photoshop Elements 4.0 launches immediately after the import completes. 
7. Select all the imported pictures by pressing Ctrl-A.  
8. Prepare the stopwatch. 
9. Do the following three things simultaneously: 

a. Press Ctrl-Alt-M to run the Auto Smart Fix Selected Photos function. 
b. Start the stopwatch. 
c. Start the iPARK device.  

10. A progress dialog will appear. 
11. When Photoshop Elements has finished fixing all the photos, the progress dialog will disappear. Stop the 

stopwatch and the iPARK device when that happens. 
12. Record the elapsed time on the stopwatch.  
13. Delete all the imported pictures from the system's hard disk. 
14. Empty the Recycle Bin. 
15. Reboot the system. 
16. Repeat the test two more times. 

 
We report the time, in seconds, that Photoshop Elements 4.0 took to auto smart fix the images. Lower times 
indicate faster performance and so are better 

Test using Apple iTunes 6.0.5 
Intel provided the file, mixTest.wav, this test uses. The file has the following key characteristics: 
 

• Length (hh:mm:ss): 01:09:29 
• Size: 701 MB (735,557,138 bytes) 
 

We performed the following steps to run this test: 

Installing iTunes 6.0.5 
1. Reset the system to the base test image. 
2. Download iTunes 6.0.5 from http://www.apple.com/itunes/download/.  
3. Launch the iTunes installer with setup defaults. 

a. Choose Setup Language.  
b. Click OK. 
c. Click Next at the Welcome to iTunes 6 Installer screen. 
d. Select the I accept the terms of the license agreement radio button. 
e. Click Next. 
f. Click Next at the About iTunes screen. 
g. Accept all defaults. 
h. Click Next at the Setup Type screen. 
i. Click Next at the Choose Destination Location screen. 
j. Click Next at the Born to be together screen. 
k. Click Finish at the Installation Successful screen. 

4. Copy the mixTest.wav file to My Music. 
5. Launch iTunes via its desktop icon. 
6. Click Agree at the License Agreement. 
7. Click Next at the Welcome to iTunes screen. 
8. Uncheck the Add MP3 and AAC files option. 
9. Uncheck the Add WMA files option, and click Next. 
10. Choose No, I’ll change the file and folder names myself, and click Next at the Keep iTunes Music Folder 

Organized screen. 
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11. Choose No, take me to my iTunes Library, and click Finish at the iTunes Music Store screen. 
12. Under the Edit menu, select Preferences. 
13. Click the Advanced tab. 
14. Click the Importing tab. 
15. From the drop-down menu next to Import Using, choose MP3 Encoder. 
16. Uncheck Play songs while importing. 
17. Uncheck Create filenames with track number. 
18. Click OK. 
19. Exit iTunes. 
20. Reboot the system. 

Running the iTunes 6.0.5 performance test 
1. Launch iTunes via its desktop icon. 
2. From the file menu, select Add File to Library. 
3. Browse to the My Music directory, and choose the test file (mixTest.wav) to add to the library. 
4. Click Open after you select the file. 
5. iTunes will now show this file in its song-list pane. 
6. Right-click the file, and select the option Convert Selection to MP3.  
7. Start the iPARK device at the same time as the conversion process. 
8. During the encoding process, iTunes shows that it is creating a new mixTest file with an Incomplete in the 

Time column beside that file. 
9. When the converting progress bar disappears, iTunes has finished the encoding. 
10. Stop the iPARK device when encoding completes. 
11. Use Windows Explorer to locate the output mixTest.mp3 file in the iTunes directory within the My Music 

folder. 
12. Right-click the file, and choose Properties. 
13. Calculate the difference between the file Created and Modified times. This time is how long iTunes took to 

encode the file to .mp3 format. 
14. Highlight the two mixTest items in the iTunes Library. 
15. Right-click, and select Clear. 
16. Check the box that says Do not ask me again, and click Remove. 
17. Click Move to Recycle Bin. 
18. Empty the Recycle Bin. 
19. Repeat the test two more times. 

 
We report the time, in seconds, that iTunes took to convert the file. The time we report is the difference of the file 
creation and modification times. Lower times indicate faster performance and so are better. 

Test using InterVideo iVideoToGo for iPod 4.5 
Intel provided the file, kitesurfing.avi, this test uses. The file has the following key characteristics: 
 

• Length (mm:ss): 02:01 
• Size: 416 MB (436,644,352 bytes) 
• Video resolution: 720 x 480 
 

We performed the following steps to run this test: 

Installing the InterVideo iVideoToGo test 
1. Reset the system to the base test image. 
2. Download InterVideo iVideoToGo for iPod from http://www.InterVideo.com/jsp/iVideoToGo_Profile.jsp.  
3. Install iVideoToGo with its default settings. 
4. Copy the file kitesurfing.avi to My Videos. 
5. Reboot the system. 

Running the InterVideo iVideoToGo test 
1. Launch iVideoToGo for iPod via its desktop icon.  
2. Click the Convert File button. 
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3. Drag the kitesurfing.avi file from My Videos to the Source region with the label Import item(s). The main 
screen will appear. 

4. Create a folder on the Desktop named iPod. 
5. Specify the Desktop as the Target location at which iVideoToGo should store its output. 
6. In the Copy as setting, select MP4-Apple iPod, and select iPod as the device.  
7. Click the button with the hammer icon to open the Optional Settings dialog. 
8. The General and MP4 settings should appear. 
9. On the General Tab, select NTSC in the Output Video System drop-down menu. 
10. Click OK. 
11. Prepare the stopwatch. 
12. Do the following three things simultaneously: 

a. Click the Start Copying button at the bottom right of the main screen.  
b. Start the stopwatch. 
c. Start the iPARK device.  

13. The progress dialog will appear. 
14. When iVideoToGo finishes the copy operation, a dialog box will appear. Stop the stopwatch and the 

iPARK device at the same time.  
15. Record the elapsed time on the stopwatch. 
16. Open the output folder, the iPod folder on the desktop, and delete the file iVideoToGo created. 
17. Empty the Recycle Bin. 
18. Reboot the system. 
19. Repeat the test two more times. 

 
We report the time, in seconds, that InterVideo iVideoToGo for iPod took to convert an mpeg file to an iPod-
compatible MP4 file. Lower times indicate faster performance and so are better. 

Test using Microsoft Windows Movie Maker 2.1 
Intel provided the file, kitesurfing.avi, this test uses. The file has the following key characteristics: 
 

• Length (mm:ss): 02:01 
• Size: 416 MB (436,644,352 bytes) 
• Video resolution: 720 x 480 
 

We performed the following steps to run this test: 

Setup 
1. Reset the system to the base test image. 
2. Copy the kitesurfing.avi to the desktop 

 
This application is part of Windows XP Service Pack 2, so we did not need to install it. 

Running the Microsoft Windows Movie Maker test 
1. Launch Movie Maker by clicking the start button and going to programs  Windows Movie Maker.  
2. In the Movie Maker window, click the File menu item, and select Import into Collections.  
3. Navigate to the DV test file, select it, and click the OPEN button.  
4. Select the DV video scenes by pressing Ctrl-A. 
5. Drag those scenes to the video time line at the bottom of the screen.  
6. Click the File menu item, and select Save Movie File.  
7. In the Save Movie Wizard (Movie Location), select My computer, and click Next.  
8. Click Next in the Saved Movie File dialog.  
9. In the Movie Setting dialog, click Next and start the iPARK device at the same time.  
10. The DV movie will start encoding, and a progress bar will appear in the Saving Movie dialog.  
11. Windows Movie Maker has finished encoding when the progress bar disappears. 
12. Stop the iPARK device when encoding is complete. 
13. On the Movie Maker screen, a Completing the Save Movie Wizard dialog will appear. Uncheck the box 

“Play movie when I click Finish”.  
14. Click Finish. 
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15. Find the Movie.wmv output file.  
16. Right-click the file, and select properties.  
17. You will see a Created field and a Modified field.  
18. Subtract the Created time from the Modified time to get the time Windows Movie Maker took to encode 

the file.  
19. Delete the Movie.wmv file. 
20. Select and delete all scenes in the Movie Maker window. 
21. Empty the recycle bin. 
22. Reboot the system. 
23. Repeat the test two more times. 

 
We report the time, in seconds, that Windows Movie Maker 2.1 took to encode a wmv file from a raw DV video 
file. Lower times indicate faster performance and so are better. 
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Appendix A – Price information 
 
Figure 1 below presents the price information for the test systems. 
 
System OEM System A OEM System B OEM System C 

Processor AMD Turion 64 X2 
Mobile TL-52 Intel Core Duo T2300E Intel Core Duo T2400 

Processor frequency 1.6 GHz 1.66 GHz 1.83 GHz 
Unit price ($) 1,213.99 1,023.99 1,218.99

We show only the unit price here, and not the taxes or shipment fees, because of complications we encountered 
in placing the order. For example, due to having to replace a defective system, we had different types of shipping 
and thus different shipping costs. We felt the unit price was the fairest basis for comparison. 

Figure 1: Purchase information for the three systems. 
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Appendix B – Test system configuration information 
This appendix provides detailed configuration information about each of the test mobile PCs, which we list in 
alphabetical order. 
 

System OEM System A OEM System B OEM System C 
General 
Processor and OS kernel: 

(physical, core, logical) 
/ (UP, MP) 

1P2C2L / MP 1P2C2L / MP 1P2C2L / MP 

Number of physical 
processors 1 1 1 

Single/Dual Core 
processors Dual Dual Dual 

System power 
management policy 

Windows Power 
Management-Portable / 

Laptop 

Windows Power 
Management-Portable / 

Laptop 

Windows Power 
Management-Portable / 

Laptop 
Processor power-saving 

option 
AMD PowerNow! 

Technology 
Enhanced Intel 

SpeedStep Technology 
Enhanced Intel 

SpeedStep Technology 
System dimensions 

(length x width x height) 13” x 9 ½” x 2 3/8”  13” x 9 ½” x 2 3/8”  13” x 9 ½” x 2 3/8”  

System weight 6 lbs. 6 lbs. 6 lbs. 
CPU 
Vendor AMD Intel Intel 
Name Turion 64 X2 Mobile Core Duo Core Duo 
Model number TL-52 T2300E T2400 
Stepping 2 8 8 
Socket type and number 

of pins Socket S1g1 mPGA-479M mPGA-479M 

Core frequency (GHz) 1.6 1.66 1.83 

Front-side bus frequency 1600MHz HyperTransport 
technology 667MHz 667MHz 

L1 Cache 64 KB + 64 KB 32 KB + 32 KB 32 KB + 32 KB 
L2 Cache 1 MB (512 KB per core) 2 MB (Shared) 2 MB (Shared) 
Platform 
Motherboard model 

number HP 30B5 HP 30B2 HP 30B2 

Motherboard chipset NVIDIA GeForce 6150 Intel i945GM Intel i945GM 
Motherboard revision 

number A2 03 03 

System/motherboard 
serial number 2CE6250L2R 2CE62901XB 2CE6250L3R 

Bios name and version Phoenix F.06 Phoenix F.0B Phoenix F.09 
BIOS settings Setup default Setup default Setup default 
Memory module(s) 
Vendor and model 

number 
Samsung 

M470T6554CZ3-CD5 
Samsung 

M470T6554CZ3-CD5 
Samsung 

M470T6554CZ3-CD5 
Type PC2-4200 PC2-4200 PC2-4200 
Speed (MHz) 533 533 533 
Speed running in the 

system (MHz) 266 266 266 

Timing/Latency (tCL-
tRCD-tRP-tRASmin) 4-4-4-11 4-4-4-11 4-4-4-11 
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Size 1024 MB 1024 MB 1024 MB 
Number of memory 

module(s) 2 x 512 MB 2 x 512 MB 2 x 512 MB 

Chip organization (Single-
sided, Double-sided) Double-sided Double-sided Double-sided 

Channel (Single/Dual) Dual Dual Dual 
Hard disk 
Vendor and model 

number 
Hitachi 

HTS541080G9SA00 Fujitsu MHV2080BH PL Hitachi 
HTS541080G9SA00 

Size 80 GB 80 GB 80 GB 
Buffer Size 8 MB 8 MB 8 MB 
RPM 5400 5400 5400 
Type SATA 150 Mb/s SATA 150 Mb/s SATA 150 Mb/s 

Controller nForce 410/430 MCP Intel 82801GHM (ICH7-
M) 

Intel 82801GHM (ICH7-
M) 

Driver NVIDIA 5.10.2600.650 Intel 5.5.0.1035 Intel 5.5.0.1035 
Operating system 
Name Windows XP Home Windows XP Home Windows XP Home 
Build number 2600 2600 2600 
Service pack 2 2 2 
File system NTFS NTFS NTFS 
Kernel ACPI Multiprocessor PC ACPI Multiprocessor PC ACPI Multiprocessor PC 
Language English English English 
Microsoft DirectX version DirectX 9.0c DirectX 9.0c DirectX 9.0c 
Graphics 
Vendor and model 

number 
NVIDIA GeForce Go 

6150 
Intel Mobile 945GM 

Express Chipset Family 
Intel Mobile 945GM 

Express Chipset Family 
Type (P=PCI Express, 

A=AGP 8X, 
I=Integrated) 

I I I 

Chipset GeForce Go 6150 Intel GMA 950 Intel GMA 950 
BIOS version 5.51.28.39.30 1313 1313 
Memory size 256 MB 128 MB 128 MB 

Resolution 1280 x 800 x 32-bit color 
(60Hz) 

1280 x 800 x 32-bit color 
(60Hz) 

1280 x 800 x 32-bit color 
(60Hz) 

Driver NVIDIA 8.4.6.1 Intel 6.14.10.4543 Intel 6.14.10.4543 
Sound card/subsystem 
Vendor and model 
number 

Conexant High Definition 
Audio 

Conexant High Definition 
Audio 

Conexant High Definition 
Audio 

Driver Conexant 3.21.0.0 Conexant 3.21.0.0 Conexant 3.21.0.0 
Ethernet 
Vendor and model 

number 
NVIDIA nForce 

Networking Controller Intel PRO/100 VE Intel PRO/100 VE 

Driver NVIDIA 50.2.4.0 Intel 8.0.19.0 Intel 8.0.19.0 
Wireless 
Vendor and model 

number 
Broadcom 802.11a/b/g 

WLAN 
Intel Pro/Wireless 

3945ABG 
Intel Pro/Wireless 

3945ABG 
Driver Broadcom 4.10.40.1 Intel 10.1.0.15 Intel 10.1.0.15 
Modem 
Vendor and model 

number 
HDAUDIO Soft Data Fax 

Modem with SmartCP 
HDAUDIO Soft Data Fax 

Modem with SmartCP 
HDAUDIO Soft Data Fax 

Modem with SmartCP 
Driver CXT 7.47.0.50 CXT 7.33.0.52 CXT 7.33.0.52 



 
 

 
14 

 
 
 

Principled Technologies, Inc.: Performance comparison of three 
consumer notebook PCs with Intel and AMD processors 

Optical drive(s) 
Vendor and model 

number Philips SCB5265 Philips SCB5265 Philips SCB5265 

Type (CD-ROM, CD-RW, 
DVD-ROM, DVD-W) CD-RW/DVD-ROM CD-RW/DVD-ROM CD-RW/DVD-ROM 

USB ports 
Number 3 3 3 
Type USB 2.0 USB 2.0 USB 2.0 

Other 
Ricoh 

SD/MS/Pro/MMC/xD 
Card Reader 

Ricoh 
SD/MS/Pro/MMC/xD 

Card Reader 

Ricoh 
SD/MS/Pro/MMC/xD 

Card Reader 
IEEE 1394 ports 
Number 1 1 1 
Monitor 
LCD type WXGA WXGA WXGA 
Screen size 14.1” 14.1” 14.1” 
Battery 

Type HP HSTNN-IB32 Lithium-
Ion 

HP HSTNN-IB32 Lithium-
Ion 

HP HSTNN-IB32 Lithium-
Ion 

Size (length x width x 
height) 8” x 2 1/4” x 1 5/8” 8” x 2 1/4” x 1 5/8” 8” x 2 1/4” x 1 5/8” 

Rated capacity 8800mAh / 10.8V (95Wh) 8800mAh / 10.8V (95Wh) 8800mAh / 10.8V (95Wh) 
Weight 1 lb. 6 oz. 1 lb. 6 oz. 1 lb. 6 oz. 

 
 

Disclaimer of Warranties; Limitation of Liability: 
PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS 
TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR 
IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING 
ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE 
RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS 
EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE 
ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.  
 
IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE 
AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S SOLE AND EXCLUSIVE 
REMEDIES ARE AS SET FORTH HEREIN. 

 

Principled Technologies, Inc. 
4813 Emperor Blvd., Suite 100 

Durham, NC 27703 
www.principledtechnologies.com 
info@principledtechnologies.com 

Principled Technologies is a registered trademark of Principled Technologies, Inc. 
All other product names are the trademarks of their respective owners 

Figure 2: Detailed system configuration information for the three test notebook PCs.



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


